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MEMORANDUM FOR DEPUTY UNDER SECRETARY OF THE ARMY 
(DEFENSE EXPORTS AND COOPERATION) 
(DASA(DE&C)/SAAL-ZN) 
DEPARTMENT OF THE ARMY 

DEPUTY ASSISTANT SECRETARY OF THE NAVY 
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DEPARTMENT OF THE NAVY 

DEPUTY UNDER SECRETARY OF THE AIR FORCE 
(INTERNATIONAL AFFAIRS) 
DEPARTMENT OF THE AIR FORCE 

DEPUTY DIRECTOR FOR SECURITY ASSISTANCE 
DEFENSE FINANCE AND ACCOUNTING SERVICE 
DENVER CENTER 

SUBJECT: Implementation of Electronic Countersignature Process for Leases (DSCA 
03-16) 

REFERENCE: (a) DSCA Memorandum I-Ol/009272-PMD "Implementation of 
Electronic Countersignature Processes (DSCA 01 -21)" 

(b) Anns Export Control Act, Chapter 6 

Reference (a) implemented the electronic coordination and countersignature of Letter of 
Offer and Acceptance (LOA) documents. This capability was initially limited to LOA 
documents, in that the authority to sign the lease determination cannot be delegated 
below the Director, DSCA, and additionally, the ability to generate PDF files of leases 
was not available. These issues have been resolved, and leases will now be electronically 
coordinated and countersigned. The following policy guidance and instructions are 
provided for this purpose and should be given wide distribution to everyone involved in 
the document preparation and coordination process of leases. 

a. Electronic countersignature procedures are mandatory for all countries' leases 
with the exception of emergency situations and classified leases. For these 
exceptions DSCA will accept hard copy documents and all DSAMS milestones must 
still be entered for these documents. DSCA should be notified in advance that these 
documents will be processed in hardcopy form. 



b. DSCA is notified automatically when lease documents have moved to "proposed" 
status in DSAMS. We will then expect an e-mail requesting DSCA approval and 
forwarding all applicable files (cover memorandum, and when required, the 
congressional notification certification). E-mails submitting packages for 
countersignature must be sent to policy-dsca@dsca.mil. DSCA cannot review the 
package until both of these actions have taken place - the "proposed" status change 
and receipt of the e-mail. 

c. In order to discriminate between lease documents received electronically, a 
specific naming convention for files submitted for countersignature is required. Each 
e-mail subject line and each PDF file for a lease should include the lease designator. 
If the lease is an amendment, that too should be addressed in the naming of the lease 
file. For example, a DSCA lease to Bandaria could have the following file names: 
"BN-Q-ZAA-BASIC-PKG.pdf' (for a basic lease) or "BN-Q-ZAA-A02.pdf' (for 
amendment 2). The subject line of the e-mail should reflect the same name as the 
lease file attachment. 

d. The electronic countersignature process requires the use ofDSAMS and Adobe 
Writer for PDF file creation. Instructions on how to create a PDF file of a lease in 
DSAMS are attached. The PDF lease files are submitted in the e-mail to DSCA 
(policy-dsca@dsca.mil). 

e. As with LOAs, DSCA reviewers will enter comments in the "Lease Remarks" 
section ofDSAMS. This field is at the "lease" level and does not automatically 
identify which document version the reviewer is commenting on (e.g., Amendment 2, 
Basic Lease, etc.). To track these comments, DSCA reviewers will use a specific 
format when creating a title for their comments. The title must be entered as follows: 
Document Version, Revision Number (if applicable), Individual's Office, 
ConcurlNonconcur. A sample entry might read: "A02, Rev2, ERASA-ASA, 
Nonconcur." DSCA reviewers must enter Lease Remarks for all nonconcurrences. 
Comments may also be entered for concurrences (optional). 

f. Implementing agencies should use existing DSAMS Management Flags to 
provide notification, as a minimum, when documents have been countersigned by 
DSCA (Milestone -- DCSGN), returned from DSCA (Milestone -- DDOCRTN), or 
rejected from DSCA (Milestone -- DCSGNRJ). 

g. When the lease is countersigned and the implementing agency has received 
notification that the lease is in "offered" status (OSTATUS), the implementing 
agency will sign the document and send it to the customer. Once the lease is in 
"offered" status, DSAMS will post "DSCA Approval Authorized" and the date of the 
DCSGN milestone in the countersignature block. DFAS-DEI A Y will receive 
Management Flags when a lease moves to "offered" status and "implemented" status 
(ISTATUS). 



Reference (b) requires a detennination that there are compelling foreign policy and 
national security reasons for leasing, rather than selling defense articles, and that the 
defense articles are not needed for public use for the duration of the lease. The authority 
to make this determination is not delegated below the Director, DSCA, and continues to 
require his/her signature, vice an electronic signature. DSAMS report RP 111 "Lease 
Certificate of Detennination" generates the lease determination, which is printed out by 
DSCA and signed by Director, DSCA prior to the DSCA Countersignature Milestone 
(DCSGN) being posted in DSAMS. 

If you have any questions regarding this matter, please contact Ms. Dawn Burke at (703) 
601-3864 or e-mail dawn.burke@dsca.mil.Guidance in this memorandum is effective 
immediately. 

Attachments: 
(1) Lease Milestone Matrix 
(2) Creating Lease PDF Files 

cc:DSADC 
USASAC 
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Attachment 1 
Lease Milestone Matrix 

MILESTONE NAME DETAILS 

LEASEINIT Lease Initialized DSAMS creates this milestone when a lease is created 
(Initialize Lease Window). 

DSTATUS Case Status Any case versions created will create this milestone. 

LEASEASGN 

LEASERETD 

MILAP 

MILSGN 

DAPREQ 

PSTATUS 

'Development' Whenever the case version is "Restated", this milestone 
will be created. Whenever a case version is 
returned/rejected by DSCA or the State Department, 
this milestone is created. 

Lease Assigned to DSAMS creates this milestone when the PREPLEASE 
Preparer workflow task is assigned to an activity (Assign Task 

Window). 

Lease Returned 
from Preparer 

MilDep Approval 

MilDep Signature 

DSCAApprvl 
Requested 

Case Status 
'Proposed' 

DSAMS creates this milestone when the PREPLEASE 
workflow task is completed (Complete Task Window). 

Enter this milestone when the case version document is 
approved by the MILDEP document (Case Milestone 
List Window). 

Enter this milestone when the MILDEP has signed the 
case version document (Case Milestone List Window). 
There must be a MILAP milestone for the case version 
before this milestone can be created. When you enter 
this milestone, the case version status will be changed 
to the appropriate status. 

Enter this milestone when the case version document 
was sent to DSCA for approval and countersignature 
(Case Milestone List Window). 

DSAMS will create this milestone when the case 
version status is changed to "Proposed". If you are 
changing the case version status from "Development" 
to "Proposed", there must be a MILAP and MILSGN 
milestone before this milestone can be created. If you 
are changing the case version status from "Canceled" to 
"Proposed", there must be a MILAP and MILSGN 
milestone; and no ASTAP and OSTATUS milestone 
before this milestone can be created. 



MILESTONE NAME 

DOCMNTSENT Document Sent 
from IA 

SDWVR Secretary of 
Defense Waiver 
Requested 

SDWVRAP Secretary of 
Defense Waiver 
Approved 

SDWVRRJ Secretary of 
Defense Waiver 
Rejected 

DCSGNRJ DSCA Rejection 

DDOCRTN 

CSTANOT 

STANOTEND 

STLST 

DSCA Document 
Return 

Statutory 
Notification to 
Congress 

Statutory 
Notification 
Period Ends 

State Department 
List 

DETAILS 

Enter this milestone to indicate when the document 
(Lease, modification, etc.) has been sent to the 
customer. 

Enter this milestone when a waiver is requested from 
the Secretary of Defense for the case (Case Milestone 
List Window). 

Enter this milestone when a waiver is approved by the 
Secretary of Defense for the case (Case Milestone List 
Window). There must be a SDWVR milestone for the 
case version before this milestone can be created. 

Enter this milestone when a waiver is rejected by the 
Secretary of Defense for the case (Case Milestone List 
Window). There must be a SDWVR milestone for the 
case version before this milestone can be created. 

Enter this milestone when the case version document 
was rejected by DSCA (Case Milestone List Window). 
There must be a DAPCS milestone for the case version 
before this milestone can be created. 

The date that DSCA returns an unapproved document 
to the MILDEP based on MILDEP request. This 
milestone is not used to indicate that the document has 
been rejected. Milestone DCSGNRJ is used to indicate 
rejection. 

Enter this milestone when the DSCA submits the 
statutory Section 62(a) notification to the Congress 
(DSCA Statutory Congressional Notification Window). 

DSAMS creates this milestone when you enter the 
DSCA submittal of the statutory Section 62(a) 
notification to the Congress (DSCA Statutory 
Congressional Notification Window). The milestone 
date is based on the Period End Date calculated or 
entered in the window. 

DSAMS creates this milestone when the State 
Department List was submitted by DSCA. This 
milestone is not applicable to leases, however, due to 
the setup ofDSAMS, it must be posted before the 
DCSGN milestone can be posted. 



MILESTONE 

DCSGN 

STAP 

OFFERED 

OSTATUS 

OFFERACC 

CGDISCREP 

NAME 

DSCA 
Countersignature/ 
Countersign 
Proposed Lease 

State Department 
Approval 

Offered 

Case Status 
'Offered' 

Offer Accepted 
by Customer 

CGandDSAMS 
Values Disagree 

DETAILS 

Enter this milestone when the case version document 
was countersigned by DSCA (Case Milestone List 
Window). There must be a DAPCS, MILAP and 
ST AP (if the State Department Approval checkbox is 
checked) milestone for the case version before this 
milestone can be created. 

Enter this milestone when the State Department 
approves the Section 62(a) case version document 
(Case Milestone List Window). There must be a 
DSTATUS and MILAP milestone for the case version 
before this milestone can be created. 

Enter this milestone when the case version status is 
ready to be changed to Offered. There must be a 
MILSGN milestone for the case version before this 
milestone can be created. When you enter this 
milestone, the case version status will be changed to 
"Offered". 

DSAMS will create this milestone when the case 
version status is changed to "Offered". If you are 
changing the case version status from "Development" 
or "Proposed" to "Offered", there must be a MILAP, 
MILSGN, OFFERED, DCSGN and STAP milestone 
before this milestone can be created. If the 
Congressional Notification Checkbox is checked, there 
must be a ST ANOTEND milestone. 

Enter this milestone when the customer signs the case 
version document (Case Milestone List Window). 
Enter the customer signature date as the milestone date. 
When you enter this milestone, the case version status 
will be changed to "Accepted". 

DSAMS creates this milestone when the CG 
Transactions from DIPS do not match the DSAMS 
Values. DSAMS performs a validation of the Total 
and Net Case Values between the DSAMS computed 
values and the CG values. If these values do not 
match, this milestone is created. 



MILESTONE NAME DETAILS 

ASTATUS Case Status DSAMS will create this milestone when the case 
'Accepted' version status is changed to "Accepted" (Case 

Milestone List Window - ToolslMILDEP 
Options/Offer Accepted). If you are changing the case 
version status from "Offered" to "Accepted", there 
must be an OFFERACC milestone before this 
milestone can be created. 

DOCVAL Document (Navy) Enter this milestone when the case version has 
Validation been validated. 

FINIMP Financial DSAMS creates this milestone when DF AS indicates 
Implementation that all financial requirements have been met (initial 

deposit received). NOTE: This does not implement 
the case version in DSAMS. 

MILIMP MilDep DSAMS will generate this milestone when the 
Implementation MILDEP manually implements a case version (Case 

Milestone List Window). 

ISTATUS Case Status DSAMS will create this milestone when the case 
'Implemented' version status is changed to "Implemented". If you are 

changing the case version status from "Accepted" to 
"Implemented", there must be a FINIMP, OAAPPROV 
(required by Army and Navy only) milestones before 
this milestone can be created. 

LEASEEXP Lease Expiration Identifit:(s the date that a lease will expire. This 
milestone will be created when the lease document is 
implemented. 

CSTATUS Case Status DSAMS will create this milestone when the case status 
"Closed" is changed to "Closed". This milestone will be 

associated with the current implemented case version. 



Attachment 2 
Creating Lease PDF Files 

To create a PDF file of a lease in DSAMS, the following steps are required: 

a. Go to the View menu in DSAMS 
b. Select Response Documents 
c. Select RP 109 Lease 
d. Enter the lease designator data 
e. Lease Previewer will display the Lease 
f. Go to the File menu in the Previewer 
g. Select Print 
h. Go to the Name dropdown menu to select printer (you will not actually print a 

document from your printer) 
1. Select Clientl(user name) \Acrobat Distiller for your printer 
J. Select OK 
k. Assign a file name to the lease, using the lease designator as the name, when 

prompted 
1. Acrobat Writer will open, and display the PDF file ofthe lease 
m. Go to the File menu in Acrobat Writer 
n. Select Send Mail 
o. An e-mail will open with the lease attached 
p. Attach a copy of the forwarding cover memorandum, and when required, the 

congressional notification certification to the e-mail 
q. State the document name in the e-mail's subject field 
r. Send the e-mail topolicy-dsca@dsca.mil 


